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What’s New in
Chief Architect X9

Welcome to Chief Architect X9. This guide has been written to help our upgrading 
customers make a smooth transition from earlier versions of Chief Architect to Chief 
Architect X9. 

Contents
• Before You Begin
• New and Improved Features

Before You Begin
There are many new features in Chief Architect X9, and many existing features have 
changed. These changes affect the way Chief Architect functions, so it is very important to 
be familiar with them. 
• Getting Started Check List on page 2
• For Files Created in Version X8 and Prior on page 4
• Files Created in Version X7 and Prior on page 5
• Files Created in Version X6 and Prior on page 5
• For Files Created in Version X5 and Prior on page 6
• For Files Created in Version X4 and Prior on page 6
• For Files Created in Version X3 and Prior on page 7
• For Files Created in Version X2 and Prior on page 7
Chief Architect X9 can open the .plan and .layout files from prior versions. Files with the 
older .pl and .la file extensions are no longer supported and cannot be opened by Chief 
Architect X9. Before opening any files created in earlier versions of Chief Architect, it is 
important to be aware of changes made in the newest version and the effect they may have 
on your legacy plan and layout files. For details, see Files Created in Version X7 and Prior on 
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page 5, For Files Created in Version X2 and Prior on page 7. 
Please note that files saved in the latest program version cannot be read by older versions 
of the software. When a legacy file is saved in the version X9, an unaltered copy of the 
original file is created in the Chief Architect X9 Data folder, under Archives, which can still 
be opened in the original version.
As in all software, every new program version introduces changes to its functionality as well 
as to the user interface. If you choose to bring a project forward, be sure to take a few 
moments to look it over in the new version and confirm that the new functionality does not 
require you to make any modifications. Particularly if you have an approaching deadline, 
you may find it best to finish the current project in the version of the software in which you 
began it. 

Getting Started Check List
The following checklist suggests steps you should take before migrating your files to Chief 
Architect X9. More information about each of these steps can be found after the checklist.
1. Check for and Install Program Updates
2. Review the New Features List
3. Migrate Legacy Library Files
4. Migrate Custom Graphics Files
5. Review Your Preferences Settings
6. Create new custom Template Plan and Layout files
7. Set up Custom Toolbar Configurations
8. Backup Entire Plan
9. Check www.chiefarchitect.com for more information

1. Check for and Install Program Updates
Program updates contain improvements to the original release version and we recommend 
using the most current version available. By default, Chief Architect checks for program 
updates every day when you launch the program. Please note that program updates are 
available for download, which means that you need internet access to acquire them.
You can check for updates at any time: 
• Select Help> Download Program Updates from the menu. 
• Visit the Program Updates page on the Chief Architect Web site at www.chiefarchi-

tect.com. 
2. Review the New Features List 
There are a number of important reasons why you should familiarize yourself with the new 
and improved features in Chief Architect X9:
• New and improved features allow you to produce drawings more efficiently, so it is to 

your advantage to use them. 

http://www.chiefarchitect.com/
http://www.chiefarchitect.com/
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• Some changes to existing functionality may affect your accustomed drawing style and 
thus your productivity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your 
preferred Preferences settings. 

See New and Improved Features on page 9. 
3. Migrate Legacy Library Files 
Library content from previous program versions cannot be installed or copied into the Chief 
Architect X9 library. If you have Chief Architect version X5 through X8 installed on your 
computer, the Migrate Settings dialog will display after you activate the license, allowing 
you to migrate Preference settings, toolbars, library content, and more for use in Chief 
Architect X9. If multiple legacy versions are present on the system, only the data associated 
with the most recent will be migrated. 
You can import library files from versions X1 through X5 at any time by selecting Library> 
Import Library (.calib, .calibz) from the program menu. In addition, library files from 
versions 10 and prior can be imported by selecting Library> Convert Legacy (.alb) Library 
Files from the program menu.
4. Migrate Custom Graphics Files
If you have custom graphics files, including textures, images or backdrops, that you were 
using in a previous program version, you can copy them manually using your operating 
system for use in Chief Architect X9. 
• Copy custom texture files to the Chief Architect X9 Textures folder located in the Chief 

Architect X9 Data folder. 
• Copy custom image files to your Chief Architect X9 Images folder located in the Chief 

Architect X9 Data folder. 
• Copy custom backdrop files to your Chief Architect X9 Backdrops folder located in the 

Chief Architect X9 Data folder. 
In Chief Architect X8 through X1, custom graphics were saved in the Chief Architect Data 
folder, as they are in version X9. In version 10, they were located in the program’s 
installation directory, in folders that began with “My”. Custom backdrops, for example, 
were saved in “My Backdrops”. 
Texture and image files are not listed in the Library Browser. These files can be assigned to 
material and image objects, however, which are stored in the library so it is important to 
retain them.
5. Review Your Preferences Settings 
Although you can migrate your Preferences settings from Versions X5 through X8 into 
Version X9, the settings that are available in Version X9 may differ from previous program 
versions. You should review all the settings in the Preferences dialog to make sure that they 
are set to suit your drawing needs.
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6. Create new custom Template Plan and Layout files 
Chief Architect X9 installs a selection of template plan and layout files that have been set up 
to take advantage of the program’s updated tools and features. Although you can migrate 
your template files for use in Version X9, for best results it is recommended that you either: 
• Use the installed templates when creating new plans and layout files in Chief Architect 

X9
• Use the installed templates as the basis for creating new custom templates.
If you choose to continue using custom template files that you created in a previous 
program version, it is very important that you take the time to carefully review all the 
default settings in the file, making sure that they will continue to suit your needs in X9. 
First, make copies of your custom templates in the Chief Architect X9 Templates directory 
The Templates directory is located in the Chief Architect X9 Data folder. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save 
any changes you make by selecting File> Save.
If you do choose to continue using a legacy template plan, it is best to also use a legacy 
layout template from the same program version, as well. As with a template plan, take the 
time to go through the layout template’s defaults and make sure they are suited for use in 
X9 and that their line weight scales do not conflict with those in your template plans.
7. Set up Custom Toolbar Configurations 
It is possible to migrate toolbar configuration files from previous versions to Chief Architect 
X9; however, it is possible that your migrated toolbars will be missing new tools available in 
Version X9. 
We recommend that you set up your custom toolbars the way you would like them in Chief 
Architect X9. You may find it most effective to customize your toolbars as you get used to 
working in the new program version, rather than beforehand.  
8. Backup Entire Plan
Before migrating a legacy file created in Chief Architect X8 or prior, it is a good idea to open 
the plan in the program version in which it was created and use the Backup Entire Plan tool 
(Export Entire Plan in version X3 and prior) to export the plan with all associated support 
files, including textures, backdrops and images.  
9. Check www.chiefarchitect.com for more information 
If you have additional questions about the changes in Chief Architect, up to date 
information is available in the Support section of our web site. You can also post questions 
on the Chief Talk web forum at www.chieftalk.com.

For Files Created in Version X8 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X8 or prior, bear in mind the following before you open legacy files in 
Chief Architect X9. 

https://chieftalk.chiefarchitect.com/
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1. Layer Names
In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it 
possible to assign different names to the same layer in different layer sets. In Version X9,this 
option is no longer supported. When a legacy file is opened in X9, the layer names used in 
the currently active layer set will be retained and any other layer names in other layer sets 
will be discarded.

Files Created in Version X7 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X7 or prior, bear in mind the following before you open legacy files in 
Chief Architect X9. 
1. Boxed Eaves
In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they 
extend into exterior rooms with “Use Soffit Surface for Ceiling” specified when located 
between the roof baseline and an interior room. In some legacy plans opened in Version X9, 
the Length value for Boxed Eaves may need to be modified in the Roof Plane Specification 
dialog.
2. Uppercase Text
The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and 
prior, it was an option for Room Labels and Schedules only. In legacy plans opened in 
Version X8, any Schedules present in the drawing will be assigned a Custom Text Style, as 
will their associated Schedule Defaults. If any Schedule Default is set to Use Layer for Text 
Style and no objects are present on that layer, a new Schedule Text Style will be created and 
assigned to that layer. Room Labels are treated similarly: if any are present, they and their 
defaults will use a Custom Text Style. If a given Room Label or Schedule has been sent to 
layout more than once and was set to use different Text Styles in each layout view, it is 
possible that its appearance may be affected in some views.

Files Created in Version X6 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X6 or prior, bear in mind the following before you open legacy files in 
Chief Architect X9. 
1. Built-in Appliances
In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base 
cabinets had incorrect sizing data. In legacy plans opened in Version X9, these appliances 
will not fit into the cabinet correctly and will need to be replaced. Built-in dishwashers are 
particularly affected.
2. Formatting of Bulleted and Numbered Lists
In Version X7, various improvements were made to the way lines of Rich Text are spaced. In 
legacy plans opened in Version X7, Rich Text objects with bulleted and numbered lists may 
require adjustments.
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3. Chief Blueprint Font
The Chief Blueprint font was improved for Version X6, with decreased top and bottom 
spacing. The change in spacing may increase the overall height of text objects using this font 
in X6 files opened in Version X9. X5 and prior legacy files will not be affected by this change.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X5 or prior, bear in mind the following before you open legacy files in 
Chief Architect X9. 
1. Named Values for Doors and Windows
In Version X6, the Named Values door_style_name, door_type_name, and 
window_type_name were shortened to style_name and type_name. Any object labels or 
text macros using these Named Values in legacy plans opened in Version X9 will need to be 
replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X4 or prior, bear in mind the following before you open legacy files in 
Chief Architect X9. 
1. Roof Overhangs and Framing
In Chief Architect X4 and prior, roof overhangs were measured to the outside of the 
subfascia, whereas in Version X5 and later, they are measured to the outside of the fascia or 
shadow boards, if present. In legacy plans opened in Version X9, this will not affect the 
appearance of roof planes in floor plan view because in X4 and prior, roof plane polylines 
represented the projected framing area whereas in Version X9 they represent the total 
projected area. But, the position of the fascia and subfascia will shift, as will the length of 
the rafters.
2. Door Swing Direction and Materials
In Chief Architect X4 and prior, exterior doors that swing outward display interior material 
on exterior side of door. This was corrected in Version X9. Doors modified to work around 
the old behavior could be affected in legacy plans opened in Version X5.
3. Door Swing Direction and Louvers
Improvements to door louver direction may affect louvers in all doors with the exception of 
bifold doors.
4. Wrapped Door/Window Lintels and Window Sills
In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those 
that were not wrapped. In legacy plans opened in Version X9, the extents of wrapped lintels 
and sills will be adjusted so that they equal their Extend setting.
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5. Cabinet Feet
The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork 
symbol to insert into cabinets effectively. In Version X9, the offset is set in the Cabinet 
Specification dialogs. When legacy plans are opened in Version X5, cabinet foot offsets are 
set to 0 and transferred to their containing cabinet, if one exists. Any customized or 
independently placed cabinet feet will be affected.
6. Object Labels in Cross Section/Elevation Views
If a “Label” layer is turned on in a cross section/elevation view and objects of that type are 
visible in the view, then those objects’ labels will display in that view when the plan is 
opened in Version X9.
7. Transparent Materials
In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing 
were visible in rendered views even when their Index of Refraction was set to 1.0. When 
legacy plans are opened in Version X9, Transparent materials with an Index of Refraction of 
1.0 are transferred to the General Material class and assigned a Transparency value of 
100%. This will not affect these materials’ appearance in ray trace views, but will make 
them completely invisible in rendered views.
8. Invisible Beams
The legacy Invisible Beam check box was removed from the Wall Specification dialog. 
When legacy plans are opened in Version X9, any Invisible Beam walls will be converted to 
Invisible Walls. 

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X3 or prior, bear in mind the following before you open legacy files in 
Chief Architect X9.
1. Text Styles
The appearance of a number of objects that include text - including object labels, the North 
Pointer, Sun Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can 
now be controlled using Text Style. Their appearance may be altered somewhat in legacy 
plans opened in Chief Architect X9.
2. Light Sources
The illumination created by light fixtures and Added Lights was improved in Chief Architect 
X9. Lighting in legacy plans may appear noticeably brighter when viewed in version X9.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the 
following file management changes and structural enhancements before you open legacy 
files in Chief Architect X9.
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1. Legacy file formats
Chief Architect 9.5 and prior files were saved in  .pl and .la the file formats. These file 
formats files are no longer supported and cannot be opened in version X9. 
2. Material textures, images, and backdrops
Chief Architect X2 and prior installed with a catalog of library content, including a selection 
of material textures, images, and backdrops. This library catalog is no longer installed with 
the program because it is now available for download on-demand, so it will be possible to 
open a legacy plan in version X9 and encounter numerous missing file warnings. To avoid 
this, we recommend using the Export Entire Plan feature in the original program version to 
create a folder that includes the plan and all associated textures, images, and backdrops 
before opening this file in X9. This tool is renamed Backup Entire Plan in version X9.
3. Floor and ceiling finish thicknesses
In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and 
objects such as railings, stairs, landings, cabinets, fixtures, and furnishings measured their 
Floor to Bottom height from the subfloor. These objects now measure their Floor to Bottom 
height from the floor finish surface by default, so it is possible that you may notice height 
changes for these objects - particularly in saved, annotated cross section/elevation views.
4. Riser heights and landing thicknesses
The default Best Fit Riser Height for stairs that do not reach the next level has been updated 
from 9” (225 mm) in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X9.
5. Auto Adjust Height
The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust 
Height checkbox. If a cabinet, fireplace, fixture, furniture, or other library symbol had 
Follow Terrain unchecked in version X2 or prior and was located in a room with a floor 
height other than the default for the current floor, then the object’s Floor to Bottom Height 
will change to equal that room’s floor height. The object’s position in the model will not 
change, however. 
6. Adjustable Thickness Walls
In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When 
a legacy plan file is opened in version X9 and these wall types are detected, they are 
replaced by an updated, non-generic wall type. Framed walls and Railings will also acquire 
1/2” (13 mm) thick layers of sheetrock on each side.
7. Stairwells defined by railings
Interior railings that used a generic, single-layer wall type drawn in older program versions 
will acquire layers of sheetrock when the plan is opened in version X9. This can affect the 
appearance of staircases where they join to a floor platform. To address this issue, select 
the railing and move it 1/2” (13 mm) away from the top edge of the staircase. 



 9

8. Deck rooms
In legacy plans opened in Chief Architect X9, Deck rooms with Advanced Deck Framing built 
retain the framing but have Automatic Deck Framing turned off by default. Decks with no 
Advanced Deck Framing built are converted to Balcony rooms.
9. Material definitions and light sources
Settings in the Define Material dialog that affect materials’ appearance of brightness have 
been modified. The Ambient setting was removed, and the Diffuse setting for materials in 
legacy plans will be set to 100% when opened in version X9. 
The Quality setting for light sources set to use Soft Shadows in ray tracing was also 
modified. Lights using Soft Shadows in legacy plans will be set to use Medium quality. The 
Light Diameter of light sources in legacy plans is capped at 4” (100 mm).
10. Structural Member Reporting
When a plan created in Chief Architect X2 or prior is opened in Chief Architect X9, Materials 
Lists are set to calculate Total Lineal Length. For a combination of lineal length and piece 
count, select Mixed Reporting in the Structural Member Reporting dialog.
11. Fill New Framing Members
In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief 
Architect X9 it applies to the entire plan. As a result, it is turned off by default in legacy 
plans opened in version X9.

New and Improved Features
The following is a list of new and improved features in Chief Architect Version X9.

Installation
• New Migrate Settings dialog lets you migrate Preference settings, toolbars, library con-

tent, and more into the current program version.
• Obsolete Migrate Library Catalogs dialog was replaced by the Migrate Settings dialog.
• 32-bit program versions will no longer be offered.

Program Overview
• New support for touch screen gestures.

File Management
• Opening files with .pl and .la file extensions is no longer supported.

• The Backup Entire Plan  tool can now save files in folders that contain other files.
• Multiple picture files can now be imported as a group.

Preferences and Default Settings
• New Layout Background Color setting in the Preferences dialog.
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• Multiple Saved Defaults can be selected and edited as a group.
• New Texture Compression troubleshooting option in the Preferences dialog.
• New Record Timing Log troubleshooting option in the Preferences dialog.
• New Mouse Movement Optimizations and Mouse Scroll Sensitivity settings in the 

Preferences dialog, only available in the Mac version of the software.
• Removed obsolete Shared Patterns folder setting from the FOLDERS panel of the 

Preferences dialog.
• Removed obsolete settings from the RENDER panel of the Preferences dialog.
• Removed obsolete LAYERS panel from the Preferences dialog.

Toolbars and Hotkeys
• New Button Size option in the Preferences dialog lets you control the size of the toolbar 

buttons without adjusting your system settings.

Displaying Objects

• Enhanced Select Drawing Group  edit tools let you move objects to different Drawing 
Groups.

Editing Objects
• New options in the Delete Objects dialog.
• Camera symbols in floor plan view can now be selected using an Edit Area marquee.
• Improved speed of Undo operations.

CAD Objects
• The CAD Block Management dialog now has an object preview and an Add to Library but-

ton.
• The Revision Cloud Specification dialog now has an object preview.

Walls, Railings, and Fencing
• Improved feedback provides warning when walls have a connection problem.
• New feedback provides warning when walls are drawn at irregular angles.

Rooms
• New Room Type Defaults dialogs.
• New Floor/Ceiling Platform Defaults dialog.
• New Shelf Ceiling option creates a plant shelf over a selected room.
• The default Ceiling Structure and Finish can now be specified for all room types.

Text, Callouts, and Markers
• The Legacy Compatible Size option for Text Styles is now only available in legacy files in 

instances where it is actually in use.
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Doors and Windows

• New Wall Niche  tool.
• It is now possible to specify zero trimmers for doors and windows.
• The default door and window casing can now be replaced directly from the library.

Cabinets
• Cabinet doors and drawers can now be drawn open in 2D and 3D views.
• Cabinet door style, drawer style, and hardware can now be customized for individual cab-

inet face items.
• Separate countertop overhangs can now be specified for each side of a base cabinet.
• New Always Present option for cabinet toe kicks with Closed Toes.
• Custom Countertops can now be located by dimensions in cross section/elevation views.
• Custom Countertops now have an object preview in their specification dialog.
• New option to prevent an automatic cabinet filler from generating in the space between 

two cabinets that meet at only one corner.

Electrical
• Switches and outlets can now be snapped to cabinet boxes and soffits. Lights can be 

snapped to the sides of soffits, as well.

Schedules and Object Labels
• New available columns for Cabinet and Room Finish Schedules.
• New 3D Object Preview Options for Door and Window Schedules.
• Code, Comment, Description, and Manufacturer information can now be specified in the 

specification dialog for most objects rather than the Components dialog.

Foundations
• Brick ledges can now be automatically generated in stem walls and grade beams.
• The Slab Specification dialog now has an object preview.

Stairs, Ramps, and Landings

• New L-Shaped Stairs  and U-Shaped Stairs  tools.
• The railings on Landings can now be specified.
• Stair, ramp, and landing railings can now use panels as well as a middle rail.
• Newel and baluster spacing can now be specified for stairs, ramps, and landings.
• Drawing previews now display for most Stair Tools.
• Improved control over top and bottom rails on stairs, ramps, and landings.
• Improved snapping of stairs to walls as they are drawn and edited.

• The Click Stairs tool was renamed Straight Stairs , while the Straight Stairs tool was 
renamed Draw Stairs .
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• The Stair Landing Specification dialog now has an object preview.
• The Newels at First Tread check box was replaced by a Has Newel Posts option that affects 

all newels.

Roofs
• New Flush Eave option produces boxed eaves that are flush with the adjacent exterior 

wall.

• New Elevation Reference option for manually drawn Ceiling Planes .
• Obsolete Rebuild Walls/Floors/Ceilings and Build Fascia and Roof Trim settings removed 

from the Build Roof dialog.

Framing
• Treated Sill Plates are no longer specified in the Foundation Defaults dialog and can now 

instead be specified on a wall by wall basis.

The Library
• Improved Library Search.
• Improved functionality and feedback when replacing an object with an item from the 

library.

Materials
• Multiple components can now be selected and edited on the MATERIALS panel of object 

specification and defaults dialogs.
• New Retain Aspect Ratio option in the Define Material dialog for material textures.

3D Views
• Camera views and overviews can now be copied and pasted.
• New Ambient Occlusion and Bloom options add realism to 3D views.
• Shadows and reflections are now enabled and disabled for individual cameras.
• Removed obsolete Brighten Ceilings option from the 3D View Defaults dialog.

Rendering and Ray Tracing

• New Toggle Shadows  and Toggle Reflections  tools.
• Removed obsolete Final View and Final View with Shadows tools.
• Improved program performance in 3D views with shadows.
• New Save as 360° Panorama option for ray trace views creates a spherical image that can 

be viewed in a variety of other applications.
• Bump maps can now be used in camera views.
• New Use Normal Map option for materials.
• Removed obsolete Export to POV-Ray option.
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Importing and Exporting

• New Export 360 Panorama  option for Standard rendered views creates a spherical 
image that can be viewed in a variety of other applications.

Materials List
• Materials Lists can now be exported for use in BuilderTREND software.

Layout
• Layout pages can now be moved by dragging and dropping in the Project Browser.

Printing and Plotting
• The Save as PDF File dialog no longer populates the File name field with a name that 

includes the view type.

Ruby Console
• New named values for the cabinets, rooms, and the current layer set.
• New named values for floor number, Drawing Order, and layer line and text style proper-

ties.
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